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 ABSTRACT 

 

This paper compared performance of commercially available tool coatings for 

micromilling of wrought H13 tool steel in minimum quantity lubrication condition. 

Performance of uncoated WC-Co tool was evaluated against six different coatings --

Nano3, Uni+, TiSiNext, AlTiN, TiN, and TiAlN. Line and area surface finish of 

micromilled channels, and channel width were used as tool evaluating criteria. Scanning 

electron microscopy observation revealed the similar wear mechanism of coated 

microtools; the thin coating was worn out in abrasive mode following by attrition wear of 

the WC-Co substrate due to spalling of built-up edges and substrate. Although the 

measured surface finish was higher than the theoretical value, both Nano3 and Uni+ 

produced lowest surface finish compared to other coatings. A low cutting speed of 

20m/min significantly produced lower and stable surface finish compared to those after 

40 m/min cutting speed.  
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1. INTRODUCTION  

Molds and dies used for mass production are a large investment that will 

eventually degrade or get damaged during their life. Replacing a mold is costly so repair 

is usually preferred, but this requires long lead times and can cause production down 

time. The current most common method of repair consists of using welding to fill cracks 

in the mold, heat treating the mold, then using machining to reshape the mold. This is a 

costly process that has downsides, such as the difficulty to machine the hardened tool 

steel that is commonly used in molds. 

This research is part of a larger project to repair molds and dies using a 

combination of Directed Energy Deposition (DED) and micromilling. DED allows for 

cracks in the workpiece to be filled using the same material as the workpiece. 

Micromilling will then be used because it can be used for reshaping materials deposited 

by DED. 

This project is specifically looking to find the optimal micromilling parameters 

and the best coating for wrought H13 tool steel, which is a commonly used mold and die 

material. These results will then be used in a future project to compare with DED created 

material. 
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2. SCOPE AND OBJECTIVE 

The objective of this research is to optimize the micromilling of mold material by 

studying: 

• Tool Coating 

• Tool Life 

• Surface Finish 

• Cutting Parameters 

The scope of this research includes: 

• Selecting square end milling tools without coating and commercially 

coated with AlTiN, Nano3, TiAlN, TiN, TiSiNext, and Uni+ 

• Using wrought unhardened H13 tool steel 

• Varying cutting speed while maintaining a specific and practical chip 

load and depth of cut 

• Studying tool performance by slot quality 

• Using Minimum Quantity Lubrication (MQL) as cutting fluid during 

micromilling 
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3. LITERATURE REVIEW 

As the world has an increased need for more miniaturized products, micromilling 

has provided a way for creating the miniature products or the dies and molds for creating 

those products. 

3.1. H13 vs D2 Tool Steel 

H13 and D2 tool steels are both commonly used in a range of mold and die 

applications. 

3.1.1. Composition 

 There is a large difference in the chromium and carbon percentage that leads to 

differences in machinability of the steels. The higher amount of chromium and carbon 

lead to higher hardness in the material which gives it better wear resistance but also 

makes machining more difficult. D2 tool steel has a hardness of about 58 HRC while 

H13 tool steel has a hardness of about 52 HRC.  

Table 1: Element Composition of H13 and D2 Tool Steels (wt%) [1] 

Tool Steel C Mn Si Cr Ni Mo V 

H13 0.32-

0.45 

0.2-0.5 0.8-1.2 4.75-

5.50 

0.3 1.1-1.75 0.8-1.2 

D2 1.40-

1.60 

0.6 0.6 11.0-

13.0 

0.3 0.7-1.2 1.1 

 

3.1.2. Heat Treatment and Mechanical Properties 

Standard heating treating procedure for H13 tool steel is heated to 1050ºC then 

quenched and tempered at 600ºC from 15 minutes to multiple hours to achieve different 

hardness depending on the desired results [2]. Generally, the longer the tempering time 

the lower the hardness. Barhami et al. (2005) found that after 90 minutes of tempering 
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there was a temporary increase in hardness from 35 HRC to 45 HRC that was attributed 

to carbide precipitations.  

3.1.3. Application 

D2 is a cold work steel used in applications such as cold forming molds, deep 

drawing molds, and cold rolling reels [3]. It’s high toughness and wear resistance give it 

good dimensional stability in high production applications. H13 is a hot work steel used 

in applications such as hot forging dies, hot extrusion channels, and high-pressure dies 

due to its high hardness and resistance to high-temperature fatigue and wear [4]. 

3.2. Metal Additive Manufacturing 

Metal additive manufacturing provides a way to make parts with unique 

structures and geometries that are not possible through traditional manufacturing 

techniques. There are many different methods of metal additive manufacturing that all 

have their advantages and disadvantages. 

In Binder Jetting (BJ), droplets of a binder are deposited onto a powder bed to 

join particles and then the binder is cured. This is done layer by layer to build up the 

part. The biggest advantage of binder jetting is that it can be used with almost any 

powder, such as ceramics, metals, and polymers [5]. When used for metal additive 

manufacturing, after curing the part is sintered to increase its strength [6]. 

In Wire Arc Additive Manufacturing (WAAM), welding wire is used as the 

deposited material and an electrical arc is used as the heat source [7]. The process 

involves depositing layer by layer of material to build up the part and can be done on any 

work surface. This process has a very high material deposition rate making it quicker to 
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make large parts. The downside of this process is that the layer thickness is dependent on 

the size of available welding wire, with typical layer heights between 1 and 2 mm. This 

means it cannot be used for small or high precision parts. 

Cold Spray Additive Manufacturing (CSAM) consists of spraying particles at 

very high speed into a substrate to cause plastic deformation and bonding [8]. The 

advantages of this process are a short production time, high flexibility of uses, and low 

thermal effects. It can be used for surface treatment and surface defect repair. It does, 

however, lead to high surface roughness, low dimensional accuracy, and high porosity. 

Powder Bed Fusion (PBF) uses a thin layer of powder then fuses it with the heat 

source, such as a laser or electron beam. Another layer of powder is added on top, and 

the process is repeated to build the part. This results in a part that has high dimensional 

accuracy and usually only needs minimal post-processing. A downside of powder bed 

fusion is that the part must be built within the powder bed, so there is a limitation on the 

size of the part being made and it cannot be built on an existing workpiece because it 

requires a flat surface for the layer of powder. One of the more common forms of this 

process is Selective Laser Melting (SLM). 

In DED, a wire or powder is fed to where the heat source contacts the work 

surface. This allows for dimensional freedom as the material can be deposited only 

where it is needed and does not require a powder bed. It has an inferior level of 

dimensional accuracy as PBF and requires more post-processing. The ability to deposit 

material locally by the DED process makes it ideal for mold repairing. 
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The use of DED does provide some challenges that must be accounted for. One 

of the issues with DED created H13 tool steel parts is that the deposited steel has a 

higher hardness value than wrought H13 steel [9]. Park et al. (2016) studied the effect of 

energy input on the hardness of H13 and D2 tool steels deposited by the directed metal 

tooling process, which was based on DED. They found that the hardness of both metals 

decreased with an increase of input energy. This was attributed to both a change in 

microstructure from the increased energy and a decrease in carbon in the deposited 

material. The deposited D2 steel had a lower hardness than the wrought D2 steel. This 

was attributed to the different microstructures formed in DED process. Deposited D2 

steel formed an entirely dendritic structure compared to the martensitic structure of the 

wrought D2 steel which led to the difference in hardness [9]. 

3.3. Mold Repair Processes 

Traditional mold repair techniques mainly rely on some form of welding to fill 

cracks. This can lead to part damage due to the heat affected zone. A technique using a 

combination of laser cladding and milling was proposed by Jeng et al. (2001)[10]. They 

were able to add to an existing mold using laser cladding and then use milling to 

accurately resize the new material, but at the time did not deem the process a feasible 

way to perform mold repair due to the high layer thickness of the laser cladding process. 

Zhang et al. (2019) proposed a method of mold repair using a combination of DED and 

milling but reversed the order of the operations from that performed by Jeng et al [10], 

[11]. They started by milling away the damaged section of the mold and then refilling it 
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using DED to restore the original dimensions. They found that by heat treating the mold 

they had strong bonding between the mold and the deposited material. 

3.4. Micromilling 

3.4.1. Micro Versus Macro 

While the basic concepts of machining are transferable from macromilling to 

micromilling, there are new challenges presented as the size of the tool decreases as 

discussed by Chae et al. (2006) [12]. The size of the tools means that even small 

vibrations can have a large effect on tool life and machining accuracy. It can also be 

difficult to detect defects on the tool. 

The ratio of cutting-edge radius to undeformed chip thickness becomes much 

more critical when micromilling. Many different ratios have been presented by Oliveira 

et al. (2015) ranging from 0.14-0.40 [13]. This range was dependent on the tool and 

workpiece materials. Aramcharoen et al. (2009), who studied micromilling of H13 tool 

steel, tested ratios from 0.2-2.0 and found that the best ratio of undeformed chip 

thickness to cutting edge radius was 1.0 [14]. 

Tool runout is another concern that arises when micromilling. While the effects 

are negligible when macromachining, the combination of spindle runout and small 

diameter of the cutting edge can lead to poor surface finish or catastrophic tool failure. 

Wang et al. (2020) studied tool runout and found that surface roughness increased with 

tool runout and that runout can lead to “single-tooth cutting” [15]. With a two-flute end 

mill, “single-tooth cutting” can lead to a high surface roughness and a shortened tool 

life. Oliaei et al. (2016) also found that uneven tool wear can have results that appear 
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like tool runout [16]. As one cutting edge experiences more wear than the other, the tool 

may begin to experience single tooth cutting and a high surface finish. Their 

recommendation was to have a radial immersion of 60% to help balance the cutting-edge 

wear. 

3.4.2. Surface Roughness 

Davoudinejad et al. (2020) studied tool wear in the micromilling of nitride 

hardened tool steel and found that surface finish went from rough to smooth and back to 

rough as tool wear progressed [17]. They found that there was a high initial surface 

roughness coming from scratches that were left on the surface from the new tool, but 

after a certain amount of tool wear the more rounded cutting edge of the tool led to a 

smoother surface finish for a short period of time until excess tool wear caused another 

increase in surface roughness. Muhammad et al. (2021) found that cutting speed was the 

most important parameter for minimizing surface roughness when machining Inconel 

718, with 48% of the variability [18]. They also found that tool coating had a minimal 

effect on the surface roughness, with a contribution percentage of about 10%. 

Hassanpour et al. (2016) found that spindle speed was an even more influential 

parameter with 94.8% of the variability when machining Ti6Al4V [19].  

Varghese et al. (2019) studied the relationship between surface roughness and 

tool-life in micromilling of 304 stainless steel [20]. Their experiment involved using 

their tools until breakage and studying the surface roughness of the channel at different 

points. They found that the tool life had three distinct stages. The first 15% of the tool 

life had high variation in the surface roughness, which was attributed to the tool chipping 
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as it made initial contact with the workpiece. The second stage that went until about 50% 

of the cutting length had a constant surface roughness. The last stage of tool life then 

saw an increase in surface roughness before the tool broke. They also identified two 

types of tools, those with similar cutting-edge radii and those that had one sharp and one 

rounded cutting radii. They observed that the tools with type similar cutting-edge radii 

had a lower tool life but also a lower surface finish, while the tools with different radii 

had more than double the cutting length but had a higher surface finish. 

3.4.3. Tool Coatings 

Tool coatings extends the life of tools in conventional machining operations. Due 

to the differences, it is important to see if there are differences in how tool coatings 

affect machining characteristics in micromilling. Muhammad et al. (2021) studied the 

effects different machining parameters, including tool coatings, had on the micromilling 

of Inconel 718 [18]. They found that tool coating was not a significant parameter in burr 

formation and surface roughness, with a contribution percentage of about 10%. This may 

be because they used of a cutting length of 10 mm. Aramcharoen et al. (2008) found that 

coatings had a “burn-in-period” where there was no difference between them [21]. With 

a longer cutting length Muhammad et al. may have found a larger difference.  

Aramcharoen et al. compared an uncoated tool to TiN, CrN, TiCN, TiAlN, and 

CrTiAlN coated tools for the micromilling of H13 tool steel without any cutting fluid. 

They found that all the coatings helped to reduce cutting edge chipping and edge radius 

wear. TiN and CrTiAlN coatings both helped to reduce flank wear. They found that the 

TiN coated tool performed the best based on flank wear, surface finish, and burr size. 
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3.4.4. Process Parameters 

Manso et al. (2020) investigated how different machining parameters affected 

surface roughness in the micromilling of H13 tool steel [22]. They studied feed per 

tooth, spindle speed, and cutting length. They found that a feed per tooth of 2 µm had the 

lowest initial surface roughness with an Rz value of 174 nm after a cutting length of less 

than 200 mm, but after 1200 mm the surface roughness was the highest with an Rz value 

of 423 nm. With a feed per tooth of 4 and 5 µm the surface roughness was higher 

initially, with an Rz value around 500 nm but reduced quickly and leveled out between 

200 and 300 nm for the rest of the cutting length. They also found that increasing spindle 

speed led to better surface quality.  

3.4.5. Use of Coolant 

The use of coolant in machining is important for evacuating chips, lubricating the 

tool, and dissipating heat. Traditional techniques of providing coolant are not possible 

because the force from the cutting fluid can be higher than the cutting forces. This can 

lead to tool deflection and damage that will cause poor machining results. Dry 

machining can be done but has issues with poor tool life and high heat. Minimum 

quantity lubrication (MQL) is an effective way of providing enough coolant to be 

effective without deflecting or damaging the tool by propelling micron sized lubricant 

within an airjet. In their study, Vazquez et al. (2015) compared dry machining, 

conventional emulsion cooling, and MQL in the micromilling of Ti6Al4V titanium [23]. 

They found that the use of MQL led to less tool wear and a less error in the shape of the 

channel. Ziberov et al. (2016) compared MQL to dry machining for micromilling of 
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Ti6Al4V titanium and found that MQL led to a better surface finish[24]. However, they 

observed that dry machining provided a better tool life. They attributed this to built-up-

edge (BUE) protecting the tool’s cutting edges. 

3.5. Machining of Wrought versus Additively Manufactured Metals 

Park et al. (2016) studied the effects of heat treatment on wrought and DED 

produced H13 and D2 tool steels [25]. The produced samples by depositing steel directly 

onto a heat-treated substrate of the same type of steel using an energy input of 37.81 

J/mm2 and a scan rate of 14.7 mm/s. The hardness of the steels before and after heat 

treatment is shown in Table 2. Before heat treatment deposited H13 had a higher 

hardness than wrought H13, while deposited D2 had a lower hardness than wrought D2, 

but after heat treatment both steels had similar hardness between wrought and deposited. 

The difference in initial hardness was attributed to a difference in microstructure caused 

by the rapid cooling rate of the DED process. After heat treatment deposited H13 had a 

similar microstructure to wrought H13, while deposited D2 was different to wrought D2, 

although they had the same hardness. Initially the deposited H13 was made up mostly of 

ferrite and austenite, but after heat treating it became tempered martensite like the 

wrought H13. In contrast the deposited D2 consisted of dendritic and eutectic structures 

which transformed into fine carbides in tempered martensite after heat treating, 

compared to the large carbides in tempered martensite that is found in wrought D2 steel. 

Wrought D2 steel is generally produced through a forging process that leads to its coarse 

carbides being parallel to the forging direction leading to anisotropic properties. The heat 
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treated deposited D2 steel had its fine carbides distributed uniformly distributed meaning 

it should have isotropic properties. 

Table 2: Microhardness of wrought and DED deposited H13 and D2 tool steels [25] 

 Wrought H13 DED H13 Wrought D2 DED D2 

Before Heat 

Treatment (VHN) 

499±6 630±5 643±14 470±10 

After Heat 

Treatment (VHN) 

528±5 535±5 719±7 745±3 

 

Koshy et al. (2002) compared the macro milling of H13 and D2 steel with no 

cutting fluid. The H13 tool steel had a hardness of 52 HRC, while the D2 tool steel had a 

hardness of 58 HRC [1]. They found that D2 steel had much higher machining 

temperatures, 700ºC, compared to H13 which was between 200 and 400ºC at a cutting 

speed of 200 mm/min. They found that with a cutting speed of 150 m/min, the cutting 

length increased from 15 m to 250 m for machining of H13 tool steel. This was done 

using a tool coated with TiCN with an upper coating of TiN. 

Sadiq et al. (2018) compared the micromilling of SLM created Inconel 718 in 

MQL to wrought material, the authors found that the SLM formed harder carbide 

particles which are more difficult to machine [26]. Bai et al. (2020) compared the macro 

milling of both DED’ed and hot-rolled A131 steel [27]. They found that at a cutting 

speed of 150 m/min, the tool wear was the same between the DED’ed and hot-rolled 

samples, but as the cutting speeds increased to 250 m/min the tool wear was more severe 

from milling the hot-rolled sample. The tool wear depth for the DED samples were 

13.55 and 16.36 µm, while the tool wear depth for the hot-rolled sample was 27.15 µm. 
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3.6. Research Gap 

The micro-milling of wrought tool steel has been studied but there has been 

limited information on the micro-milling of additively manufactured H13 tool steel. It is 

important to have a good understanding of how the specific tool coatings perform when 

machining wrought H13 steel so that they can be better evaluated when used on the DED 

deposited steel. This research studies the machinability of wrought H13 tool steel for 

comparison in a parallel study of the machinability of DED deposited H13 tool steel. 
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4. EXPERIMENTAL PROCEDURE 

4.1. Tools 

The cutting tools used were two-flute micro end mills with a diameter of 0.4 mm 

acquired from Performance Micro Tool [34] with a flute length of 0.5842 mm. The six 

types of coatings acquired from Swiss-Tek Coatings [35] were Uncoated, Nano3, Uni+, 

AlTiN, TiAlN, TiN, and TiSiNext for comparison against uncoated tools. Each of the 

coatings were given a three-letter code, shown in Table 3, and each tool was identified 

by its row and column in the box, as shown in Figure 1, to make identification easier. 

Table 3: Tool Coating Three Letter Codes 

Uncoated Nano3 Uni+ AlTiN TiAlN TiN TiSiNext 

UNC NAN UNI ALT TIA TIN TIS 

 

 

Figure 1: Tool Identification in a Toolbox 
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4.2. Materials 

The workpiece was H13 Tool Steel with an averaged hardness of 86 HRB. The 

hardness of the workpiece was recorded using a Wilson Rockwell Hardness Tester 

model 3JR. The dimensions of the workpiece were 107x82x47 mm. The composition of 

the H13 Tool Steel is shown in Table 1 and a tensile strength of 1569 MPa [36]. 

4.3. Equipment 

4.3.1. Milling Machines 

The Haas VF1 CNC mill was used to machine the workpiece for parallelism and 

to minimize damage to the new surface for micromilling. The Haas OM2 CNC mill was 

used for micro milling operations with an air bearing spindle that allows for speeds of up 

to 50,000 rpm. 

Flood cooling was used for the Haas VF1 mill, while a UNIST cool lubricator 

system with a needle nozzle was used in the Haas OM2 mill. The UNIST system 

provided micromist cooling and lubrication of the tool and workpiece at a rate of 0.084 

mL/min using Coolube 2210 EP.  

4.4. Milling Procedure 

4.4.1. Workpiece Preparation 

The first step was to machine the workpiece for parallelism. The Haas VF1 mill 

was used to face the workpiece with a depth of cut of 0.0762 mm and a cutting speed of 

40 m/min. This process was repeated until a uniform surface finish was made across the 

surface of the part and was repeated for both sides of the part. This required 11 passes on 

one side and 9 passes on the other. An Aerospace brand dial indicator with a resolution 
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of 0.0254 mm (0.001 in) was then used to verify that the parallelism was within ±0.0254 

mm (±0.001 in) as shown in Figure 2.  

  

Figure 2: Using an indicator to measure parallelism 1) Indicator, 2) Workpiece, and 3) 

Granite Reference Block 

Before machining the microtools were imaged using the Olympus STM 6 

microscope to look for any tool damage.  

The NC-code program shown in Appendix C was then written. Each operation 

would machine 5 slots into the workpiece with a 0.1 mm gap between slots. The 

workpiece had a width of ≈45 mm so the program was written to start 3 mm before the 

workpiece and then machine for 51 mm. This was to ensure that the tool would machine 

through the entire width. A sketch of the tool path is shown in Figure 4. The block was 

only machined from one direction to ensure that the MQL was always aligned behind to 
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tool to ensure that it was being applied where the cutting tool met the workpiece as 

shown in Figure 3. The program was then tested by machining with a wax block to 

verify its proper function. Three stages of machining were performed with the 

parameters shown in Table 4. 

Table 4: Parameters for each stage of Machining 

 Depth of Cut 

(µm) 

Cutting Speed 

(m/min) 

Chip Load 

(µm/flute) 

Total Cutting 

Length (mm) 

1st Stage 40 40 10 960 

2nd Stage 40 40 10 141 

3rd Stage 40 40 10 23 

4th Stage 40 20 10 23 

 

 

Figure 3: Workpiece and Setup for Micromilling: 1. Micromill, 2. MQL Nozzle, 3. 

Workpiece 

1. 

2. 

3. x 

y 
z 

0 
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Figure 4: Tool Path for Micromilling, Unit: mm, Not to Scale 

 

4.4.2. Micromilling Procedure 

4.4.2.1. First Micromilling Test 

The workpiece was secured in the compound vise on the Haas OM2 mill. A 

leveling plate was used to make the surface of the part parallel to the bed of the mill. An 

indicator mounted to the spindle was then used to verify this parallelism. The tool offsets 

were set, and the program was run. Details of this process are shown in Appendix A. A 

coated tool was tested for 20 slots. An additional tool with AlTiN coating was tested 

because of early tool failure after 15 slots.  
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After this, the process was repeated using a new tool offsetting method described 

in Appendix B.  

4.4.2.2. Second and Third Micromilling Test 

A small piece of the workpiece, with dimensions of 47x39x23 mm was cut off 

from the larger block using both a horizontal band saw and a wire electrical discharge 

machine (wire EDM). This also allowed the workpiece to fit into the Scanning Electron 

Microscope (SEM) chamber for further study. 

The second stage of testing was then performed using the same procedures as the 

previous one except for the shorter cutting length of 141 mm. Afterwards, a third stage 

was performed using a cutting length of 23 mm. See Appendices A and B for details on 

the machining procedure. 

4.4.2.3. Fourth Micromilling Test 

A third round of milling was done using the Nano3 and UNI+ coated tools at a 

cutting speed of 20 m/min to study the effect of cutting speed on surface roughness. The 

same machining procedures from the second micromilling test was used.  

4.4.3. Metrology 

Surface characterization was done using the Alicona Infinite Focus Microscope. 

Images were taken using the Olympus STM 6 Microscope, and the Tescan Vega 

Scanning Electron Microscope (SEM).  

The micro milled samples were studied with the SEM. The beginning and end of 

each channel was imaged, and energy-dispersive x-ray spectroscopy (EDS), using 

Oxford EDS detector, was used to detect if any tool coating deposited on the milled 
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slots. An uncoated tool and a tool of each coating were imaged using the SEM and EDS 

was performed to confirm the coating elements. 

The channel’s surface finish was measured with the Alicona. The procedure is 

shown in Appendix D. The line roughness, Ra, measurements were taken along a 1 mm 

long line at the center of a channel. To find the Ra value the Alicona was calibrated for 

the correct cutoff frequency (Lc) for each lens. This was done using a calibration piece 

with a known Ra value made by Mitutoyo Standard, Serial No. 348451205. The surface 

roughness, Sa, readings were taken from a 1x0.2mm area in the center of the channel 

and at every millimeter along the cutting length. 

The line roughness of the center and edges of the channels at 1, 12, and 22 mm of 

cutting length was also recorded. The width of the channels was measured using the 

Alicona’s form measurement function. The concavity angle of both an uncoated and 

Nano3 coated tool was measured using the measurement function on the Olympus STM 

6 Microscope as shown in Figure 5. 

 

Figure 5: Concavity Angle of an Uncoated Tool 
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5. RESULTS AND DISCUSSIONS 

5.1. Preliminary Machining 

The preliminary machining was a 960 mm cutting length with different coated 

tools. Graphing the Ra values of the milled surface against cutting length, as shown in 

Figure 6, reveals that higher Ra values begin between 20 and 30 mm of cutting length 

depending on the coating, indicating significant tool wear. Using this information, the 

coatings were compared for their first 20 mm of use to ensure that they were studied 

within their effective tool life.  

 

Figure 6: Surface Finish, Ra, for First 1000 mm. Depth of Cut: 40 µm, Cutting Speed: 

40 m/min, Chip Load: 10 µm/flute 

5.2. Machining 

Figure 7 shows a comparison of the first 20 mm of cutting distance for all the 

tools used. The Uncoated, Nano3, AlTiN, and UNI+ had very consistent performance 

between the tools. TiN and TiSiNext had more variability between tools with some 

performing well and others performing poorly.  
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Figure 7: Averaged Ra and ranges for first 20 mm. Depth of Cut: 40 µm, Cutting Speed: 

40 m/min, Chip Load: 10 µm/flute 
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Studying the average Ra values of the machined surface after using all the tools 

in Table 5, Nano3 and UNI+ has the lowest average Ra values and no obvious outlier 

tools. The Uncoated tools had the third lowest average Ra values but also only had two 

tools used due to having a limited number available. The TiSiNext coated tools had good 

performance from two of the tools but had one large outlier that brought up its average. 

The fourth tool had an issue with the tool offset that meant the data was not usable. The 

TiAlN coated tools were in the middle of the pack but had the only tool breakage, tool 

B3, which most likely would have brought up its average if it had continued due to the 

sharply increasing Ra values.  

Table 5: Average Ra of Machined Surface for the first 20 mm of cutting length of 

different tools 

Tool # Uncoated Nano3 AlTiN UNI+ TiN TiSiNext TiAlN 

1 0.786 0.736 0.956 0.652 0.878 2.137 1.204 

2 0.649 0.455 0.870 0.499 1.699 0.395 0.680 

3  0.866 1.164 0.661 0.664 0.701 0.733 

4  0.595 0.694 0.426 0.469  0.505 

Average 

Ra (µm) 

 

0.725 0.648 0.921 0.559 0.928 1.078 0.780 
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Figure 8: Feed Diagram showing Up-milling and Down-milling 

 

The directions of up milling and down milling are shown in Figure 8. Figure 9 

shows the difference in the channel at the center versus at the edge after ≈20 mm of 

cutting distance. It can be observed that at the edge of the channel the surface appears 

much smoother then near the center. A comparison of the Ra value between the middle 

of the channel and 10 µm from the edge of the channel along the cutting distance was 

also performed and the results are shown in Figure 10. From these results it can be 

determined that the middle of the channel always has a higher surface roughness than the 

edges. Generally, down-milling while provides a better surface finish than up-milling 

[37], but this data shows that up milling and down milling are very similar with no 

consistency on which is greater than the other. This is because the bad surface finish in 

up-milling is caused by the tool vibrating against the work piece as it cuts. In this case 

the tool is both up-milling and down-milling at the same since the tool is contained in 

the milled slot with minimal vibration. 
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(a) 

 
(b) 

Figure 9: SEM photo of channel machined using Nano3 coated tool a) Center of the 

channel and b) edge of the channel 
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Figure 10: Ra in middle vs edge of channel. Depth of Cut: 40 µm, Cutting Speed: 40 

m/min, Chip Load: 10 µm/flute 

 

 

 

 

 

  

  

  

0

0.1

0.2

0.3

0.4

0.5

0.6

0 10 20 30

R
a 

(n
m

)

Cutting Length (mm)

(a) Nano3

Middle Down Milling Up Milling

0

0.1

0.2

0.3

0.4

0.5

0.6

0 5 10 15 20 25

R
a 

(µ
m

)

Cutting Length (mm)

(b) TiN

Middle Down Milling Up Milling

0

0.1

0.2

0.3

0.4

0.5

0.6

0 5 10 15 20 25

R
a 

(µ
m

)

Cutting Length (mm)

(c) AlTiN

Middle Down Milling Up Milling

0

0.1

0.2

0.3

0.4

0.5

0.6

0 5 10 15 20 25

R
a 

(µ
m

)
Cutting Length (mm)

(d) TiSiNext

Middle Down Milling Up Milling

0

0.1

0.2

0.3

0.4

0.5

0.6

0 5 10 15 20 25

R
a 

(µ
m

)

Cutting Length (mm)

(e) TiAlN

Middle Down Milling Up Milling

0

0.1

0.2

0.3

0.4

0.5

0.6

0 5 10 15 20 25

R
a 

(µ
m

)

Cutting Length (mm)

(f) UNI+

Middle Down Milling Up Milling



 

27 

 

5.3. Surface Finish 

5.3.1. Ra versus Sa 

 The first step after collecting the data to find if there was a relationship between 

Ra and Sa. The first 20 and 138 mm of cutting distance for each tool coating was 

compared using a moving average of the data to lessen the impact of any large outliers.  

𝑷𝑪𝑪 =
𝒄𝒐𝒗(𝑹𝒂,𝑺𝒂)

𝝈𝑹𝒂𝝈𝑺𝒂
    (1) 

Where: 

PCC  : Pearson Correlation Coefficient 

cov(Ra,Sa) : Covariance of Ra and Sa 

σRa  : Standard Deviation of Ra 

σSa : Standard Deviation of Sa 

 

The Pearson Correlation Coefficient (PCC), defined in Equation 1 [38], between 

Ra and Sa of the machined surfaces for each coating is shown in Table 6. This value 

shows how close to a linear relationship Ra and Sa have; a higher PCC value means a 

more linear relationship. Nano3, AlTiN, and UNI+ show a strong positive relationship, 

while TiAlN and TiSiNext show a moderate positive relationship. TiN shows a 

negligible relationship between Ra and Sa. The differences between Ra and Sa are likely 

caused by the higher variation in Sa values that comes from taking readings over a larger 

rectangular area compared to the profile reading of Ra.  

Over the first 20 mm there is less correlation between Ra and Sa for Nano3, 

TiAlN, TiSiNext, and UNI+. This is likely because this is the region where the tool 

coating is worn out, causing more variation over the surface of the part. The AlTiN 

correlation goes down over the longer cutting distance, but this is likely caused by the 
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comparatively high variation in Ra after 50 mm, shown in Figure 11b. TiN has a 

negligible correlation between Ra and Sa for after both cutting lengths that appears to be 

caused by the unusual pattern of the Sa readings. 

Table 6: Pearson Correlation Coefficient between Ra and Sa of the machined surface 

after 20 and 138 mm of cutting length 

Cutting 

Length 

(mm) 

Nano3 AlTiN TiAlN TiN TiSiNext UNI+ 

0-20 0.48 0.93 0.55 0.28 0.40 0.72 

0-138 0.75 0.82 0.67 0.07 0.55 0.89 

  

 To better understand the difference between Ra and Sa they were both graphed 

against cutting length in Figure 11 to observe their variability. Based on these graphs, 

UNI+ and AlTiN do appear to be well correlated with very similar trend lines between 

Ra and Sa. Nano3 also appears well correlated except for a single spike in the Sa data at 

about 40 mm. This spike is most likely because Sa takes a reading from a larger 

rectangular area and may have included a defect that wasn’t included in the Ra reading. 

These results are in line with the PCC readings from Table 6, which showed that these 

three coatings had the strongest relationship. TiAlN and TiSiNext both have a similar 

trend, but the high variability of the Sa readings causes a difference in the correlation 

coefficient. This high variability is most likely caused by an issue similar to what caused 

the Nano3 Sa values to spike. The TiN values showed no real correlation with high 

variability in the Sa reading along the entire cutting length. Studying these graphs shows 

that Sa and Ra generally have a good correlation, but Sa has much high variability in its 

values because it is based on a larger surface area it covered compared to Ra. 

Aramcharoen et al. (2008) found similar trends in Ra values, although the values were 
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smaller due to a lower cutting speed and depth of cut. They also studied TiN and TiAlN 

coated tools and found that TiN provided a lower surface finish. 

 

  

  

  
Figure 11: Ra and Sa versus cutting length for coatings. Depth of Cut: 40 µm, Cutting 

Speed: 40 m/min, Chip Load: 10 µm/flute 
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5.4. Effect of Tools Coating and Cutting Speed 

The effect of cutting speed was studied using Nano3 and UNI+ coated tools. 

These coatings were selected because they had been the best performing coatings based 

on the lowest average Ra values across all the tools. All the previous data came from a 

cutting speed of 40 m/min, a cutting speed of 20 m/min was then completed to study 

how the lower cutting speed affected surface roughness. The results are shown in Figure 

12. The average Ra value for 20 mm of cutting length at 40 m/min cutting speed was 

0.455 and 0.426 µm for Nano3 and UNI+ respectively. At 20 m/min of cutting speed the 

average Ra was 0.244 and 0.241 for Nano3 and UNI+. The higher cutting speed led to 

higher tool wear which led to a higher surface roughness. 

  
Figure 12: Ra of Machined Channels at Different Cutting Speeds. Depth of Cut: 40 µm, 

Cutting Speed: 40 m/min and 20 m/min, Chip Load: 10 µm/flute 
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single Ra value from the collected data was 0.23 µm but the first data point was taken 

after 1 mm of cutting length so tool wear should already be affecting the readings. 

     𝑅𝑎′ =
5

18
𝑓𝑡 tan 𝛼              (2) 

Where: 

Ra’ : Theoretical Line Surface Roughness (µm) 

ft : Chip Load (µm/flute) 

α : Concavity Angle (degrees) 

  

This study selected 20 and 40 m/min cutting speed, 10 µm/flute chip load, for 

micromilling in MQL condition. Other researchers performed micromilling H13 tool 

steel at different milling parameters as described in Table 7. Manso et al. (2020) used a 

similar cutting speed but had a lower chip load, Aramcharoen et al. (2008) had much 

lower cutting speed and lower chip load. As a result, the Ra after machining was in the 

range of 0.1-0.15 µm. Aramcharoen et al. (2009) had Ra values in the ranging from 

0.14-0.26 µm after micromilling without cutting fluid. These results are only slightly 

lower than the results from using a cutting speed of 20 m/min in this experiment which 

ranged from 0.19-0.29.   

Table 7: Machining Parameters of other researchers 

Author Tool Diameter 

(mm) 

Cutting Speed 

(m/min) 

Chip Load 

(µm/flute) 

Cutting 

Fluid 

Manso et al. 

(2020) [22] 

0.4 37.7-57.8 2-5 Dry 

Aramcharoen 

(2008) [21] 

0.5 0.3 5 Dry 

Aramcharoen 

(2009) [14] 

0.9 0.012-0.216 0.2-3.6 Dry 
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5.5. Channel Width 

The widths of the machined channels were then compared to see if channel width 

and tool wear had a relationship. The results shown in Figure 13 are the difference from 

the initial channel width for each tool. To determine if channel width was a reliable form 

of measurement, only the first 23 mm of cutting length was studied. There should be a 

linear relationship between the data points with a slight negative trend as the tool coating 

wears away, making the tool smaller. Instead, it is observed that while some of the tools 

followed the expected trend relatively well others saw large variation between different 

tools of the same coating, such as AlTiN A2 and AlTiN A4 in Figure 13b along with all 

the tools in Figure 13e.  

This variation in channel widths is most likely from collecting the channel width 

using a top-down view of the channels. This led to issues of burrs overlapping the edges 

of the channels and the exact width being difficult to obtain. There was also a lot of 

inconsistency in the initial channel width, with a range from 381 to 407 µm. In future 

studies the channel width should be obtained using a cross section view of the part that 

may make it more accurate.  
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Figure 13: Effects of Coating on Channel Width. Depth of Cut: 40 µm, Cutting Speed: 

40 m/min, Chip Load: 10 µm/flute 
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Figure 19. The tool wear is caused by abrasive wear of the coating and spalling of the 

tungsten carbide cobalt (WC-Co) substrate. The rough surface of the fractured tool surface 

is evidence of attrition wear [39]. Breaking of large BUEs reveals the rough surface of the 

fresh tungsten carbide cobalt (WC-Co) structure. This consistency of this wear mechanism 

shows that the cutting speed was most likely too high leading to the worn-out coating, 

forming of BUEs on tool edges, and spalling of BUEs with minute amount of cutting tool 

substrate. All the tools show a similar flat surface at the cutting edge, the evidence of tool 

rubbing against the workpiece instead of actually cutting. The TiAlN tool, Figure 17, does 

not show this wear mechanism but it may be from the longer cutting length that wears the 

coating completely from the cutting edge. The remaining cutting edge appears like that of 

the uncoated tool which had the same cutting distance. The coating adhesion appears to 

be good and uniform to approximately 2 µm thick. In their study, Aramcharoen et al. 

(2008) found the thickness of their coatings to be between 1.38 µm for the TiN coatings 

up to 1.59 µm thick for the CrTiAlN coating [21]. After a cutting length of 25 mm, they 

found that the average flank wear of the tools to be between 10 µm for the TiN coated 

tools up to 30 µm for the AlTiN coated tools, meaning that the coating had worn away 

and machining was being performed by the tungsten carbide substrate. Manso et al. (2020) 

found that after 200 mm of cutting length flank wear was around 30 µm on a Ø0.4 mm 

AlTiN coated tool depending on the feed per tooth, while after 1200 mm of cutting length 

flank wear was nearing 80 µm [22]. These studies show that the tool coating wore away 

leaving the substrate to perform most of the machining resulting in the high flank wear. 

This leads to higher tool wear rates and a poorer surface finish on the workpiece. Because 
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the coating protects the cutting tool it is best practice to only use a tool while the coating 

is still present on the cutting edge. Technique to reliably detect the useful life of tool 

coating, however, is yet to be studied. 

  
Figure 14: Uncoated cutting edges after machining 141 mm. Depth of Cut: 40 µm, 

Cutting Speed: 40 m/min, Chip Load: 10 µm/flute 

 

  
Figure 15: Nano3 Coated cutting edges after machining 23 mm. Depth of Cut: 40 µm, 

Cutting Speed: 40 m/min, Chip Load: 10 µm/flute 
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Figure 16: AlTiN Coated cutting edges after machining 23 mm. Depth of Cut: 40 µm, 

Cutting Speed: 40 m/min, Chip Load: 10 µm/flute 

 

 

 

  
Figure 17: TiAlN Coated cutting edges after machining 141 mm. Depth of Cut: 40 µm, 

Cutting Speed: 40 m/min, Chip Load: 10 µm/flute 
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Figure 18: TiN Coated cutting edges after machining 23 mm. Depth of Cut: 40 µm, 

Cutting Speed: 40 m/min, Chip Load: 10 µm/flute 

 

 

 

 

  
Figure 19: TiSiNext Coated cutting edges after machining 23 mm. Depth of Cut: 40 µm, 

Cutting Speed: 40 m/min, Chip Load: 10 µm/flute 
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Figure 20: UNI+ Coated cutting edges after machining 23 mm. Depth of Cut: 40 µm, 

Cutting Speed: 40 m/min, Chip Load: 10 µm/flute 
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6. CONCLUSIONS AND RECOMMENDATIONS 

Micromilling of wrought H13 tool steel was performed using uncoated and tools 

commercially coated with Nano3, AlTiN, UNI+, TiN, TiSiNext, and TiAlN.  

The study showed: 

1. Uncoated tool was inferior to the coated tools. The tool wear mechanism was 

abrasive wear of the coating and spalling of the tungsten carbide cobalt (WC-Co) 

substrate. The rough surface of the tool surface is evidence of attrition wear. 

2. Producing the lowest and most consistent surface finish, tools with Nano3 and 

UNI+ coatings were the best performing tools when micromilling at 40 µm depth 

of cut, 40 m/min cutting speed, and 10 µm/flute chip load in MQL conditions.  

3. The cutting speed of 40 m/min was too aggressive and caused abrasive and 

attrition wear of a tool after machining only 23 mm. 

4. Channel width was not a viable means of examining tool wear when measured 

top down. Burrs on both sides of micromilled slots prevented an accurate 

measurement of channel widths. 

Recommendations 

• Future study should optimize milling parameters in minimum quantity lubricant 

to avoid attrition tool wear. 

• Since coating functions as a protective layer of a cutting tool, a comprehensive 

study on coating life and tool life would be useful. 

• This work used wrought H13 tool steel, future study should repeat with 

additively manufactured H13 tool steel. 
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APPENDIX A 

MICROMILLING PROCEDURE 

1. Insert workpiece into compound vise 

2. Use bullet level for making a flat surface as shown in Figure 21 

 

Figure 21: Using a bullet level (Top View) 1) Bullet Level and 2) Compound Vise 

3. Verify the flat surface using an indicator mounted to the spindle as shown in 

Figure 22 
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Figure 22: Using Indicator Mounted to the Spindle 1) Indicator, 2) Workpiece, 3) 

Magnetic Mounting Base, and 4) Compound Vise 

4. Secure the tool in the collet 

5. Set X and Y axis tool offsets visually at the origin of the workpiece 

6. Secure multimeter probe to tool and workpiece 

7. Turn on multimeter to measure for resistance 

8. Slowly lower the tool until the multimeter beeps showing that the tool is in 

contact with the workpiece 

9. Set the Z axis offset 

10. Turn on the micromist 

11. Run program shown in Appendix C 
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APPENDIX B 

TOOL AND PART OFFSETS FOR MICROMILLING 

This method replaces steps 6-9 in Appendix A 

1. Tape thin aluminum sheet to gage block 

2. Put a mark on the aluminum sheet where the tool will make contact 

3. Place gage block on the workpiece 

4. Aim laser height gage at the mark 

5. Zero the laser height gage 

6. Remove gage block to measure the height of the aluminum sheet 

7. Note the height of the aluminum sheet 

8. Place gage block back on the workpiece aligned so that the tool will contact 

the mark 

9. Aim the laser height gage on the aluminum sheet in a non-marked location as 

shown in Figure 23 
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Figure 23: Using Laser Height Gage 1) Magnetic Mounting Base, 2) Laser Height 

Gage, and 3) Washer with aluminum sheet 

10. Zero the laser height gage 

11. Slowly lower the tool until the height of the aluminum sheet changes 

12. Set the Z axis offset 

13. Subtract the height of the aluminum sheet and gage block noted earlier 
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APPENDIX C 

NC CODES 

% 

O66669 

(SS316L Russell H13 Block 2 6/9 15:00)  

( FEATURECAM HAAS OM2 MILLING )  

 

N35 ( OPERATION= SLOT GROOVE1 )  

N40 ( TOOL: T1 = 0.4 mm )  

N45 G01 G17 G21 G40 G90 G94  

N50 T1 M06  

N55 G54 X-3.0 Y-3.0 Z3.0 S31830 F637.0 M03  

N70 (Slot 1) 

N75 Z-0.04 

N80 X1.0 

N85 Y50.0  

N90 Z2.0  

N95 (Slot 2) 

N100 X1.5 Y-3.0 

N110 Z-0.04 

N115 Y50.0  

N120 Z2.0  

N125 (Slot 3) 

N130 X2.0 Y-3.0 

N140 Z-0.04 

N145 Y50.0  

N150 Z2.0  

N125 (Slot 4) 

N130 X2.5 Y-3.0 

N140 Z-0.04 

N145 Y50.0  

N150 Z2.0  

N125 (Slot 5) 

N130 X3.0 Y-3.0 

N140 Z-0.04 

N145 Y50.0  

N150 Z2.0  

 

N215 X3.0 Y-3.0 

 

N400 G53 G49 Z0 M09  

N410 M30 



 

52 

 

APPENDIX D 

PROCEDURE USING ALICONA INFINITE FOCUS MICROSCOPE  

1. Open IF Measurement Suite 

 

2. Log in to User Name. You can use 

your own or log in with an existing one. 

It does not matter as long as you use the 

same one every time you log in. 

 

3. Open Folder where your files are 

saved. 
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4. Open the file you want to measure 

 

For Measuring Ra 

1. Record the image of calibration 

block using the same zoom level used 

for your part readings 

(Calibration block used was Mitutoyo 

Standard Serial No. 348451205) 

 

2. Save to the same project as the rest 

of your pictures 

 

3. Open in 

ProfileRoughnessMeasurement 

 

4. Either use a saved profile path or 

create a new profile path that you will 

save 

 

5. Put Lc to manual and adjust until the 

Ra value matches the Ra value on the 

calibration block 
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6. Record the number to use when 

measuring Ra for your part 

 

7. Select View>Viewer Coordinates in 

order to see the coordinates at your 

mouse cursor 
 

8. Use the profile used for calibration 

by selecting File>Load Profile Path… 

 

9. To get an accurate Ra reading use a 

calibrated Lc value. To put in 

calibrated value select Manual then 

enter the calibrated value. 

 

10. Record the Ra value 

 

For Measuring Sa 

1. Select SurfaceTextureMeasurement for 

Sa 

 

2. Select View>Viewer Coordinates to 

see the coordinates of the mouse cursor 
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3. Select Select Fixed Rectangle and 

enter your desired width and height. 

 

4. Click the part to place the rectangle 

where desired 

 

5. Select Surface Texture to read Sa value 

 

6. Record the Sa value 

 

 

 


